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This guide introduces MeetingCentreTM, powered by WebExTM ,and provides 
basic information about using its many features. Refer to the table below to 
locate the feature or task you want to learn about. Feature descriptions and step-
by-step procedures are grouped under the larger meeting task you are 
performing, such as scheduling a meeting, sharing information, or housekeeping 
and management tasks (for example, muting and unmuting microphones). 
 
For more in-depth detail about a particular feature, consult the online Help on 
your MeetingCentre Web site. 
 

Set Up Tasks 

OBTAINING A USER ACCOUNT 

Once you obtain a user account, you can host meetings using your meeting 
service. You need not obtain a user account to attend meetings. 
 
You can obtain a user account in one of two ways: 

 The site administrator for your MeetingCentre Web site can create a user 
account for you. 

 If your site administrator has made the signup feature available, you can 
sign up for an account on your MeetingCentre Web site at any time. 

 
To obtain a user account using the signup feature: 
 
1 Go to your MeetingCentre Web site. Your address for your site is usually in 

the following format: 
<your_company> .webex.com 

2 On the navigation bar, expand Set Up. 
3 Click New Account. 
4 Provide the required information, and then click Sign Up Now. 

 

LOGGING IN AND OUT 

You must log in to your MeetingCentre Web site to schedule and start your 
meetings and access your account features. Your site administrator provides you 
with your user name and default password for your account. 
 
Note: You do not need to log in to your site to attend a meeting, unless the meeting 
host specifies that all attendees must have a user account. 
 
This option is available only if your site has the self-registration feature. 
 
To log in to MeetingCentre: 
 

1 Go to your MeetingCentre Web site. The address for your site is usually in 
the following format: 

 <your_company>.webex.com 
2 On the navigation bar, click Log In. 
3 Provide your user name and password. 

MeetingCentre 
Getting Started Guide 



  

4 Optional. To automatically log in to MeetingCentre whenever you access it, 
click the Remember user name and password check box. 

5 Click Log In. 
 
To log out from MeetingCentre: 
 
To log out from your MeetingCentre Web site, on the navigation bar at the top of 
the page, click Log Out. 
 

IF YOU HAVE FORGOTTEN YOUR USER NAME OR 
PASSWORD 

If you have forgotten either your user name or password, you can quickly obtain 
it. 
 
To obtain your user name or password: 

1 On the navigation bar, click Log In. 
2 On the Log In page, click Login Assistance. 
3 Provide your email address, and then click OK. 

 
Your MeetingCentre Web site immediately sends you an email message 
containing your account information. 
 

SETTING UP MEETING MANAGER FOR WINDOWS 

Meeting Manager is a software program that you install on your computer and 
use when participating in a meeting. Meeting Manager provides the options that 
you use to share information—such as presentations and applications—send 
chat messages, send and receive live video, take notes, record a meeting, and 
so on. 
 
The Meeting Manager software provides the work space for your meeting. 
 

SYSTEM REQUIREMENTS 

Your system must meet these requirements for installing Meeting Manager for 
Windows: 

 Microsoft Windows 95, 98, ME (Millennium Edition), XP, NT, 2000, or 
Windows Server 2003 

 Intel or AMD 400 MHz processor 
 128 MB RAM (64 MB recommended) 
 Microsoft Internet Explorer 5 or 6, Netscape 7, Mozilla 1.6, or Firefox 1.0 
 JavaScript and cookies enabled on the Web browser 
 56K or faster Internet connection 

 
If you want to share a presentation that was created using Microsoft® PowerPoint 
2002 for Windows XP, an Intel Celeron or Pentium 500 MHz or faster processor 
is highly recommended. However, you cannot share other types of presentation 
or documents unless you either: 

 Sign in to your computer as an administrator before starting or joining a 
meeting for the first time, or 

 Have a Windows NT or 2000 administrator set up your computer for you. 
 
Subsequently starting or joining an event does not require administrator 
privileges. 
 



  

To set up Meeting Manager for Windows: 
 
1 On the navigation bar, expand Set Up, and then click Meeting Manager. The 

Set Up page appears. 
2 Click Set Up. 
3 If a security dialog box appears, do one of the following: 
- If you are installing Meeting Manager on Microsoft Internet Explorer, click 

Yes. 
- If you are installing Meeting Manager on Netscape Navigator, click 
- Grant. Setup continues. A progress message box appears, indicating the 

progress of setup. 
- Once setup is complete, the Setup Complete page appears. 
4 Click OK. 
 
You can now start, schedule, or join a meeting. 

BROWSE MEETINGS PAGE (MEETING CALENDAR) 

* The Calendar is only available with a branded URL, not on MeetingCentre.net 
The Browse Meetings page includes a meeting calendar, which provides daily, 
weekly, and monthly views of all scheduled or in-progress meetings on your site, 
as well as a list of all meetings being hosted on the current date. Using the 
calendar, participants can: 

 search for a meeting 
 obtain information about a meeting 
 register for a meeting 
 join a meeting 

 
The following figure shows the Daily view of the Browse Meetings page. 
 

 

 

JOINING A MEETING 

If a meeting host invites you to a meeting, you receive an invitation email 
message that includes information about the meeting, instructions for joining the 
voice conference, and a link that you can click to join the meeting. 

 
 

This example of a meeting invitation shows the level of detail included: 
 



  

Click on this link to join the meeting. 

 
  
 
Tip:  A meeting invitation also includes a link that you can click to add the meeting to 
any calendar program that supports the iCalendar format, such as Microsoft Outlook 
or Lotus Notes. 
 
You can also join a meeting directly from your MeetingCentre Web site or from 
the host’s Personal Meeting Room page (available on branded sites). The steps 
for joining a meeting from your site differ, depending on whether the meeting is 
listed or unlisted— that is, whether or not the meeting appears on the public 
meeting calendar and the host’s Personal Meeting Room page. 
 
Once you join a meeting, instructions for joining the voice conference 
automatically appear on your screen 
NOTES: 

 To participate in a meeting, you must use Meeting Manager. If you have not 
yet set up Meeting Manager on your computer, you can do so before joining 
a meeting to avoid a delay. Otherwise, once you join a meeting, your 
MeetingCentre Web site automatically sets up Meeting Manager on your 
computer. For more information about setting up Meeting Manager on your 
computer, see “Setting up Meeting Manager for Windows.” 

 
 You need not have a user account or log in to your site to join a meeting, 

unless the host has specified that all meeting participants must have a user 
account. 

 
To join a meeting from an invitation email message: 
 
1 Click the link in the message to join the meeting. 
2 On the Meeting Information page that appears, click Join Now. 
 

Scheduling Tasks 

TYPES OF MEETINGS 

 
Using MeetingCentre, you can set up: 
 

 Scheduled meetings (using either the Quick Scheduler or the Advanced 
Scheduler) 



  

 Audio Only meetings 
 One-Click Meetings 

When setting up any type of meeting, you can specify that it is either listed or 
unlisted. 

Meeting Type Description 
Scheduled (using 
Quick Scheduler) 

A meeting that you schedule for a specific date and 
time. You can also: 

 Specify voice conferencing options 
 Send invitations to participants 
 Set up and include an integrated voice conference 

in your meeting 
 

Scheduled (using 
the Advanced 
Scheduler) 

In addition to the options you set up using the Quick 
Scheduler, the Advanced Scheduler allows you to: 

 Specify a recurrence pattern for the meeting 
 Schedule and start a meeting for another user 

who has granted you scheduling permission 
 Require attendees to register for a meeting, which 

lets you collect information from attendees and 
enhances the security of your meeting 

 Choose which default meeting privileges you want 
attendees to have 

 Choose which meeting options you want to turn 
on or off, such as chat, notes, video, and so on 

 Let attendees join the meeting before its 
scheduled starting time—that is, before you start it 

 Choose a presentation or document to share 
automatically once a participant joins the meeting 

 
Audio Only Set up a meeting that is simply a teleconference. You 

send invitations to attendees and they can add this 
teleconference to their calendars. You can set up a 
personal teleconference account and utilise your 
Reservation-less plus account or an Operator assisted 
call and add it to the calendar. 
 

One-Click An instant meeting that you set up in advance, using 
the One-Click Meeting Setup Wizard. When setting up 
a One-Click Meeting, you can: 

 Specify voice conferencing options 
 Choose which default meeting privileges you want 

attendees to have 
 Choose which meeting options you want to turn 

on or off, such as chat, notes, video, and so on 
 
You can start the meeting at any time, as often as you 
want, by clicking the One-Click Meeting link on the 
MeetingCentre navigation bar. If you also install the 
WebEx One-Click program, you can start a One-Click 
Meeting from the WebEx One-Click panel on your 
computer’s desktop, or by clicking a One-Click 
Meeting shortcut on your computer 

Listed A meeting that appears on your MeetingCentre Web 
site’s meeting calendar and your Personal Meeting 
Room page. Because these pages are publicly 
accessible, visitors can view lists of meetings on these 



  

pages. 
 

Unlisted A meeting that does not appear on any pages on your 
MeetingCentre Web site. To join an unlisted meeting, 
attendees must provide the meeting number. Your 
meeting service automatically generates a unique 
meeting number for each meeting that you host. 

 

USING THE QUICK SCHEDULER 

Whether you want to start your meeting right now, or schedule it for a time in 
the future, MeetingCentre provides an easy-to-use tool to set it up. You can 
even schedule a teleconference and invite your colleagues to join by phone. 

The one-page Quick Scheduler is a snap to use. You have your meeting 
scheduled in no time. 

To schedule a meeting using the Quick Scheduler: 

1 Log in to your MeetingCentre Web site. 

2 On the left navigation bar, click Host a Meeting> Schedule a Meeting. 

Depending on how your administrator set up your site, you see the Advanced 
Scheduler or the Quick Scheduler. 
 
3 If you see the Advanced Scheduler, click the link in the title bar to view the 

Quick Scheduler. 

 
Click here to display the Quick Scheduler 
 
4 On the Quick Scheduler page, enter the details about your meeting. For 

details, see Quick Scheduler options, next. 

 
 
5 Schedule or start your meeting. 
 
 If you scheduled the meeting time for the current time, you see the Start Now 

button. If your meeting is set for a time in the future, you see the Schedule 
Meeting button. 

 
 Scheduled meetings display on your meeting calendar and personal meeting 

page. 



  

 
Quick Scheduler Options 
 
Only a few pieces of information are required; you can set as many other options 
as you want. 
 
Use this Option… To… 

Choose a Template/ 
Set options using 
 

Select a template and use the settings saved in 
that template for this meeting. 
 
You can save time by using a template that 
includes the list of attendees you want to invite, a 
presentation you want to show before the 
meeting starts, and other options you have used 
in a previous meetings and saved as a template. 
For more details about creating and editing 
templates, consult online Help. 

Topic Enter the topic or a name for the meeting. 
Tracking codes 
 

Identify your department, project, or other 
information that your organisation wants to 
associate with your meetings. Tracking codes 
can be optional or required, depending on how 
your site administrator set them up. 
 
If your site administrator requires you to select a 
code from a predefined list, a list of codes 
appears. Select a code from the list on the left. 
Then do one of the following in the box on the 
right: 

 If a list of codes appears, select a code from 
the list. 

 Type a code in the box. 

 

5 Schedule or start your meeting. 

If you scheduled the meeting time for the current time, you see the Start Now 
button. If your meeting is set for a time in the future, you see the Schedule 
Meeting button. 

Scheduled meetings display on your meeting calendar and personal meeting 
page. 



  

Password 
Confirm Password 

Require participants to enter the password you 
set to join your meeting. 
 
Your site may require that all passwords comply 
with security criteria, such as a minimum length 
and a minimum number of letters, numbers or 
special characters. A password: 
 

 Can contain a maximum of 16 characters. 
 Cannot contain spaces or any of the 

following characters: \ ` “ / & < > == [ ] 
 
Each participant that you invite to your meeting 
receives an invitation email message that 
includes the password, unless you request that 
passwords do not appear in email invitations. 

Date Set the date you want the meeting to occur. 
Select the month, day, and year in the drop-down 
lists. Or, you can click the Calendar icon, and 
then select a date. 

Time Set the meeting's starting time and the time zone. 
To select another time zone, click the time zone 
link. 
Important the time zone you select does not 
affect the time zone setting for the meeting 
calendar on the Browse Meetings page. You and 
each attendee can select the time zone for your 
view of the calendar independently, using the 
Your time zone option on the Preferences page. 
To access this page, on the navigation bar, click 
Set Up > Preferences. 

Duration Enter the length of time you estimate that the 
meeting will continue. The meeting does not end 
automatically after the duration that you set. 

Attendees Enter the email addresses of the attendees you 
want to invite to your meeting. 
 
You can type the addresses, separating them 
with a comma or semicolon or you can click 
Select Attendees to choose attendees from your 
address book. 

Audio Options The default settings display. To select a different 
option, click Change audio option. 

 

USING THE ADVANCED SCHEDULER 

If you use the Advanced Scheduler, you can specify several options to provide 
security for and to customise your meeting. 
 
You can click the Start Now button at any time to start your meeting. If you have 
questions about the information requested on a page, click the Help button, 
located in the upper-right corner of the page, for details. 
 
To schedule a meeting using the Advanced Scheduler: 
 
1 Log in to your MeetingCentre Web site. 
2 On the left navigation bar, click Host a Meeting> Schedule a Meeting. 



  

 
 Depending on how your administrator set up your site, you see the Advanced 

Scheduler or the Quick Scheduler. 
 
3 If you see the Quick Scheduler, click the link in the title bar to view the 

Advanced Scheduler. 
4 On the Required Information. page, type the details that are required. 
 
You can choose other options, such as removing this meeting from your meeting 
calendar after the meeting is over. 
 
For an overview of this page and the information requested, click the Help button 
in the upper-right corner of the page. 
 

 

 
 
 
 
 
5 Start your meeting or add more scheduling details. 
- To start your meeting, click Start Now. 
- To add more options, click Next or click a link to another page in the 

scheduler. Then click Start Now or Schedule Meeting. 

SETTING UP AND STARTING A ONE-CLICK MEETING 

 
Using the One-Click Meeting Setup Wizard, you can specify options for an 
unscheduled meeting, and then start the meeting at any time, by clicking the 
One-Click Meeting link on your MeetingCentre navigation bar. If you also install 
the WebEx One-Click program, you can start your One-Click Meeting from the 
WebEx One-Click panel, or by clicking one of your One-Click shortcuts, which 
appear on: 
 

 Your Web browser toolbar (Internet Explorer only) 
 The WebEx menu in Microsoft Office applications 
 The right-click menu for files and applications on your desktop 

 
To set up a One-Click Meeting: 
 
1 Log in to your MeetingCentre Web site. 
2 On the top navigation bar, click My WebEx. 
3 Click the One-Click Meeting tab. 
4 Use the One-Click Meeting Setup Wizard to specify information about the 

meeting. 
5 Click Finish. 
- The Download One-Click screen appears. 

Click Start Now to start this 
meeting immediately 

Click Next to move to the next 
page in the scheduler  



  

 
6 Optionally install WebEx One-Click: 
- Click Download One-Click. 
- Save the WebEx One-Click installation program to your computer, and then 

run it. 
- Follow the instructions in the installation program. 
 
 
 
To start a One-Click Meeting from your MeetingCentre Web site: 
 
1 Log in to your MeetingCentre Web site. 
2 On the left navigation bar, click Host a Meeting > One-Click Meeting. 
 
To start a One-Click Meeting using the WebEx One-Click panel:  
 
1 Click the WebEx One-Click icon on either your desktop or taskbar. 

                                        

   

2 On the WebEx One-Click panel, click Start Meeting. 

 

 
 
To start a One-Click Meeting using a One-Click shortcut: 
 
Click one of these One-Click Meeting shortcuts, which the WebEx One-Click 
installation program set up on your computer: 
 

 Web browser button 
 

  
A Start One-Click Meeting button appears on 
the toolbar on your Internet Explorer Web 
browser. 

     

 
 WebEx menu in Microsoft Office applications 

 
One-Click Meeting commands appear on a WebEx menu 
in your Microsoft Office applications. These commands let 
you automatically share in a meeting the application or 
any document that is open in the application. 
 

Taskbar icon 
Desktop icon 



  

 
 

 Shortcut (right-click) menu for document files and applications 
 

 
One-Click Meeting commands appear on 
the shortcut menu when you right-click the 
icon for any application or document file. 
These commands let you automatically 
share the application or document in the 
meeting. 
 
 

 
 
To edit One-Click Meeting settings: 
 
1 Log in to your MeetingCentre Web site. 
2 On the navigation bar, click My WebEx. 
3 Click the One-Click Meeting tab. 
4 Use the One-Click Meeting Setup Wizard to set new options. 

Sharing – the Core of your Meeting 

SHARING OPTIONS  

MeetingCentre provides you with a variety of options for sharing information in a 
meeting. The following table describes the advantages and disadvantages 
among these options. 
 
Sharing Option Advantages Disadvantages 
Presentation 
and Document 
Sharing 

 Is faster and more 
bandwidth efficient than 
application or desktop 
sharing. 

 Is ideal for sharing 
presentations or 
documents that you do not 
want to edit during the 
meeting. 

 Lets you and participants 
annotate content. 

 Does not let you edit 
the content during the 
meeting. 

 

Application 
Sharing 

 Lets you edit the content of 
any presentation or 
document open in the 
application. 

 Lets you grant attendees 
control of the application. 

 Is ideal for software 
demonstrations. 

 Lets you and attendees 
annotate the application 
and documents that are 
open in it. 

 Requires more 
bandwidth than 
presentation or 
document sharing. 

Desktop 
Sharing 

 Lets you quickly share 
multiple applications at 
once. 

 Lets you show any part of 

 Requires the most 
bandwidth among 
sharing options.  

 Lets an attendee with 



  

your desktop, including file 
directories. 

 Lets you grant attendees 
control of your desktop, 
access files, and run 
applications. 

 Lets you and attendees 
annotate your desktop and 
any applications. 

remote control access 
any part of your 
computer and modify 
any files, which may 
be a security concern. 

Web Browser 
Sharing 

 Lets you guide attendees 
to various Web pages and 
sites on the Web. 

 Lets you grant attendees 
control of your Web 
browser. 

 Lets you and attendees 
annotate Web pages. 

 Does not display 
media effects or 
transmit sounds on 
Web pages.  

 Does not let 
attendees interact 
with Web pages 
independently. 

Web Content 
Sharing 

 Displays media effects and 
transmits sounds on Web 
pages. 

 Lets attendees interact 
with Web pages 
independently. 

 Does not let you 
guide participants to 
other Web pages. 

 

SHARING DOCUMENTS AND PRESENTATIONS 

You can share one or more presentations or documents you have created using 
word processing, presentation, or graphics programs. Document and 
presentation sharing is ideal for presenting information that you do not need to 
edit during the meeting, such as a slide presentation. 
 
Attendees view the shared document or presentation in their content viewers. 
They do not need to have the applications used to create the documents 
available on their computers. Attendees can also view any animation and 
transition effects on shared Microsoft PowerPoint slides. 
 
Once a meeting starts, you can open a document or presentation to share. You 
do not need to select it or “load” it before the meeting. 
 
While sharing a document or presentation, you can: 
 

 Make annotations 
 Use a pointer to emphasise text or graphics 
 Save it to a file 
 Print it 
 Display it at various magnifications, in miniature (thumbnails), and in a full-

screen view 
 Synchronise all participants’ displays with the display in your content viewer 

 
At any time during a meeting, you can grant attendees privileges that allow them 
to annotate, save, print, and display different views of shared presentations or 
documents. 
 
To share a document or presentation: 
 
1 On the Share menu, choose Presentation or Document. The Share 

Presentation or Document dialog box appears. 



  

 
2 Select the document or presentation that you want to share. 
 
3 Click Open. 
 
The shared document or presentation appears in the content viewer, as in the 
example below: 
 

 
 
TIP: For tips that can help you to share documents and presentations more 
effectively, see “Tips for sharing software” on page 20. 

ACCESSING TOOLS FOR SHARING                

As you start sharing documents and applications during your meeting, tools are 
available at your fingertips. 
 
In this example, the host has opened a presentation to share with meeting 
participants. 
 
Notice the changes in the window. You now have access to: 
 

 Annotation tools for highlighting and referring to elements in the presentation 
or application you are sharing 

 View tools for displaying document and presentations in different ways, such 
as showing thumbnails of the pages  

 Previous and Next buttons, for moving around in a document 
 



  

 

ANNOTATION TOOLS 

 
 
 

 
 
 
 
Tool Description 
Pointer Lets you point out text and graphics 

on shared content. The pointer 
displays an arrow with your name 
and annotation color. To display the 
laser pointer, which lets you point 
out text and graphics on shared 
content using a red “laser beam,” 
click the downward-pointing arrow. 
Clicking this button again and then 
clicking the Close button turns off 
the pointer tool. 

Text Lets you type text on shared 
content. Attendees can view the text 
you have entered after you type it 
and click your mouse in the content 
viewer, outside the text box. To 
change the font, on the Edit menu, 
choose Font. Clicking this button 
again and then clicking the Close 
button turns off the text tool. 

Line Lets you draw lines and arrows on 
shared content. For more options, 
click the downward-pointing arrow. 

Eraser tool Highlighter tool 

Rectangle tool 

Pointer tool

Text tool 

Line tool 

Annotation Color tool 



  

Clicking this button again and then 
clicking the Close button turns off 
the Line tool. 

Rectangle Lets you draw shapes, such as 
rectangles and ellipses on shared 
content. For more options, click the 
downward-pointing arrow. Clicking 
this button again and then clicking 
the Close button turns off the 
Rectangle tool. 

Highlighter Lets you highlight text and other 
elements in shared content. For 
more options, click the downward-
pointing arrow. Clicking this button 
again and then clicking the Close 
button turns off the Highlighter tool. 

Annotation Color  Displays the Annotation Color 
palette, Select a color to annotate 
shared content. The Annotation 
Color palette closes. 

Eraser Erases text and annotations or 
clears pointers on shared content. 
To erase a single annotation, click it 
in the viewer. For more options, click 
the downward-pointing arrow. 
Clicking this button again and 
clicking the Close button turns off 
the eraser tool. 

 
 

 

 

VIEW TOOLS 

 
Tool Description 
Standard View / View Thumbnails Clicking Standard View displays the 

shared content as you would 
normally view it. To display 
thumbnails, or miniatures, of shared 
pages, slides, or whiteboards to the 
side of the content, click View 
Thumbnails. This tool helps you 
locate a page or slide quickly. Click 
Standard View to return to normal 
viewing of the shared content. 

Full-Screen View Displays shared content in a full-
screen view. Helps you to ensure 
that participants can view all activity 
on your screen. Also helps to 



  

prevent participants from viewing or 
using other applications on their 
screens during a presentation. Click 
ESC to return to the content viewer. 

Zoom In / Zoom Out Lets you display shared content at 
various magnifications. Click this 
button, and then click the page, 
slide, or whiteboard to change its 
magnification. For more 
magnification options, click the 
downward-pointing arrow. 

Synchronise Displays for All For presenters, synchronises all 
participants' displays with your 
display. Helps to ensure that all 
participants are viewing the same 
page or slide, at the same 
magnification, as in your display. 

 

Sharing whiteboards  
 
Sharing a whiteboard allows you to draw objects and type text that all attendees 
can see in their content viewers. You can also use a pointer to emphasise text or 
graphics on a whiteboard.  
 
While sharing whiteboard, you can: 
 

 Display it at various magnifications, in miniature (thumbnails), and in a full-
screen view 

 Save it 
 Print it 
 Synchronise attendee’s displays with the display in your content viewer  

 
If you grant annotation privileges to attendees, you and attendees can draw and 
type on a whiteboard simultaneously. You can also allow attendees to save, 
print, and display different views of shared whiteboards.  
 
To share a whiteboard:  
 
On the Share menu, choose Whiteboard.  
 
When sharing a whiteboard: 
 

 You can add multiple pages to a shared whiteboard. For details, consult the 
users’ guide or online Help. 

 
You can share multiple whiteboards. For each whiteboard that you share, 
Meeting Manager creates a new Whiteboard tab in the content viewer.  

SHARING MULTIMEDIA IN A WEBEX MEETING  

During a meeting, you can share the following types of media files in the content 
viewer: 

 WebEx Recording Format (WRF) files 
 video files 
 audio files 
 Flash movie and interactive Flash files 



  

 Web pages  
 
You can share media files in either of two ways: 

 In a Microsoft PowerPoint presentation—you can share media files that 
play on Microsoft PowerPoint slides. Using the WebEx Universal 
Communications Toolkit, a plug-in for Microsoft PowerPoint, you can insert 
UCF media objects into your slides. Depending on the options you choose 
in the toolkit, the media object can either: 

- link to a media file that resides on your computer, another computer on your 
local network, or a remote server 

- contain a media file as part of your presentation file  
 
You can download the Universal Communications Toolkit from your meeting 
service Web site. For information about using the Universal Communications 
Toolkit, refer to the guide Getting Started with WebEx Universal Communications 
Toolkit, which is available on your MeetingCentre Web site. 
 

 As a standalone file—you can share a media file directly in the content 
viewer. Meeting Manager creates a UCF media object for the file 
automatically, which appears in the content viewer.  

 
A UCF media object contains options and controls that you can use to display or 
manipulate its associated media file.  
 
For more information about how UCF works, consult the MeetingCentre User’s 
Guide or online Help.  

GRANTING DOCUMENT, PRESENTATION, AND 
WHITEBOARD SHARING PRIVILEGES  

By default, only the presenter can share a document, presentation, or 
whiteboard during a meeting. However, you can allow all attendees or individual 
attendees to share their own presentations or documents or interact with pages, 
slides, and whiteboards that others share. You can also remove these sharing 
privileges from attendees at any time.  
 
To specify attendee privileges for shared content in the content viewer: 
 
1 In the Meeting window, on the Participant menu, choose Assign Privileges. 

The Attendee Privileges dialog box appears. 
 
2 Do one of the following: 
- To grant privileges to or remove them from all attendees at once, in the pane 

on the left, select All Attendees. 
- To grant privileges to or remove them from an individual attendee, in the 

pane on the left, expand All Attendees, and then select the attendee's name. 
 
3 On the Participants tab, under Document, select or clear the check boxes for 

any of the following sharing privileges that you want to grant to or remove 
from all attendees, respectively: 

- Save 
- Print 
- Annotate 
 
4 On the Participants tab, under View, select or clear the check boxes for any 

of the sharing privileges that you want to grant to or remove from all 
attendees, respectively: 

- Thumbnails 



  

- Any page 
- Any document 
 
5 On the Participants tab, under Meeting, select or clear the Share documents 

check box to grant to or remove the privilege from all attendees, respectively. 
6 Click Assign. 

SHARING SOFTWARE  

When you share software, attendees can follow all actions that you take. You 
can also annotate the software, or let an attendee annotate it or control it 
remotely.  
 

 You can share these types of software with attendees: 
 Applications on your computer 
 Your computer’s desktop 
 Web browsers 
 Remote computers, if you installed the Access Anywhere Agent on the 

computer  
 

To share an application: 
 
1 On the Share menu, choose Application.  
 
The Share Application dialog box appears, showing a list of all applications 
currently running on your computer. 
  

 
 
2 Optional. To view a list of applications that are installed on your computer, 

but not currently running, click View Application.  
 Use this option to locate an application you want to share, but are not 

currently using.  
 
3 In the list, select the application that you want to share. 
4 Click Share.  
 Your application appears in a sharing window on attendees' screens.  
 
 



  

LETTING AN ATTENDEE REMOTELY CONTROL SHARED 
SOFTWARE  

 
While sharing the following types of shared software, you can let an attendee 
control it remotely: 

 Application 
 Desktop 
 Web browser 

 
An attendee who has remote control of shared software can interact with it 
completely. While an attendee is remotely controlling your shared software, your 
mouse pointer is inactive. At any time, however, you can reassume control of a 
shared application and regain use of your mouse pointer.  
 
While you are sharing software, any attendee can send a request to control the 
software remotely. You can then grant control to the attendee. Alternatively, you 
can automatically grant control of shared software to any attendee who requests 
remote control.  
 
You can stop an attendee from remotely controlling shared software at any time.  
 
To let an attendee remotely control shared software: 
 
1 Do either of the following: 
 
- On the title bar of a window that you are sharing, on the Sharing menu, point 

to Allow to Control Remotely.  
 

 
 
- In the lower-right corner of your computer’s desktop, on the Sharing menu, 

point to Allow to Control Remotely.  

 
 
2 Select the name of the attendee whom you want to control the software.  
 

SHARING YOUR DESKTOP  

Desktop sharing lets you show all meeting attendees your computer’s entire 
desktop—including any applications and windows that are currently open— and 
all the actions that you take with your desktop. Desktop sharing can be useful for 
technical support. For example, you can allow a technical support representative 
to access your computer and fix a problem as you watch.  
 
While sharing your desktop, you can: 

 Control attendees’ views of your desktop. 
 Annotate your desktop, using a highlighter tool. 
 Let an attendee control your desktop remotely. For example, you can let an 

attendee edit a document on your computer. 
 Let an attendee annotate your desktop remotely.  

 
To share your desktop:  



  

 
On the Share menu, choose Desktop.  
 
Your desktop appears in a sharing window on attendees' screens.  
 
To allow an attendee to control your desktop remotely: 
 
1 On the title bar of an application you are sharing, on the Sharing menu, point 

to Allow to Control Remotely. 
2 Select an attendee to control your desktop.  
 
SHARING A REMOTE COMPUTER  
* This is not available on every site, if this is not on your site and you would like 
this feature please speak to your meeting consultant. 
 
Remote computer sharing lets you show all meeting attendees the computer’s 
entire desktop or specific applications on it, depending on how you set up the 
remote computer, and all actions that you take with the computer.  
 
Remote computer sharing can be useful if you want to show attendees an 
application or file that is available only on that computer.  
 
 
 
 
You can share a remote computer during a meeting for which you are the 
presenter, if:  

 You have installed the Access Anywhere Agent on the remote computer. 
 You logged in to your MeetingCentre Web site before joining the meeting, if 

you are not the original meeting host.  
 
For information about setting up a computer so you can access it remotely, refer 
to the Access Anywhere User’s Guide.  
 
To share a remote computer:  
 
If you have already set up a computer for Access Anywhere, you can share the 
computer during a meeting. 
 
1 On the Share menu, choose Remote Computer. The Access Anywhere 

dialog box appears. 
 

 



  

 
2 Under Remote, select the computer that you want to share. 
3 Under Applications, select an application that want to share.  
 
If you set up the remote computer so you can access its entire desktop, the 
option Desktop appears under Applications. 
 
4 Click Connect. Depending on the method of authentication that you specified 
when setting up the computer for Access Anywhere, one of the following occurs: 
 
- If you chose access code authentication, a dialog box appears, in which you 

must provide the access code that you specified when setting up the remote 
computer. 

- If you chose phone authentication, you receive a phone call at the number 
that you specified when setting up the remote computer. 

 
5 Do one of the following: 
- If you chose access code authentication, type your access code in the box, 

and then click OK. 
- If you chose phone authentication, provide your pass code by following the 

voice instructions.  
 
NOTES: 
If you are not the original meeting host, you must log in to your MeetingCentre Web 
site before joining a meeting in which you want to share a remote computer. If you 
are already in a meeting, but did not log in to your site, you must leave the meeting, 
log in to your site, and then rejoin the meeting. 
 
If a password-protected screen saver is running on the remote computer, your 
meeting service automatically closes it once you provide your access code or pass 
code. 
 
If the remote computer is running Windows NT or 2000, and you must log in to the 
computer, send a Ctrl+Alt+Del command to the computer. 
 
If you set up the remote computer so you can access multiple applications, you can 
share additional applications simultaneously. 
 

TIPS FOR SHARING SOFTWARE  

 
These tips can help you share software more effectively: 
 

 To improve the readability of shared software, attendees can use the sizing 
options on the View menu. 

 
 To improve the quality of attendees' views of a shared software, ensure that 

both your monitor display and attendees' monitor displays are set to the 
same color depth for example, 16-bit color. 

 
 Application sharing only: To save time during a meeting, begin sharing one or 

more applications before the meeting's starting time, and then minimise their 
windows. At the appropriate time during the meeting, you can then quickly 
begin sharing an application by restoring its window, without waiting for the 
application to start. 

 
 To improve the performance of software sharing, close all applications that 

you do not need to use or share. Also, close any applications that use 



  

bandwidth, such as instant messaging or chat programs, and programs that 
receive streaming audio or video from the Web. 

 
 Application and Web browser sharing only: Avoid covering a shared 

application or Web browser with another window on your computer's desktop. 
Doing so prevents attendees from viewing the area of the application or 
browser that the other window covers. Instead, a crosshatched pattern 
appears in the covered area on attendees' screens. 

 
 You can switch your display between shared software and the Meeting 

window. To conserve bandwidth, pause software sharing before you return to 
the Meeting window, and then resume sharing once you return to the shared 
application. 

 
 Use a dedicated, high-speed Internet connection when sharing software. 

Attendees using dial-up Internet connections may notice a delay in viewing or 
controlling shared software. If you want to share a Microsoft Word, Excel, or 
other document, you can improve the meeting experience for these 
attendees by using document sharing instead of application sharing.  

 

 

TRANSFERRING FILES DURING A MEETING  

As a presenter, you can publish files that reside on your computer during a 
meeting. For example, you can provide attendees with a document, a copy of 
your presentation, an application, and so on. Published files appear in each 
attendee’s Meeting window, allowing them to download the files to their 
computers.  
 
To transfer files during a meeting: 
 
1 On the File menu, choose Transfer. The File Transfer window appears. 
2 Click Share File. 
3 Select the file that you want to publish, and then click Open. 
4 Optional. Repeat steps 2 and 3 to publish additional files. The files appear in 

the File Transfer window in each participant’s Meeting window  
 

RECORDING A MEETING  

For details about using InterCall’s WebEx Recorder to record on-screen activity 
in a meeting and capture audio in a voice conference, refer to the InterCall 
WebEx Recorder and Player User’s Guide found on your resources page. 
 

Interacting with Attendees 

WORKING WITH THE PANELS  

Using the panels on the right side of the Meeting window, you can chat with 
attendees, poll them, send video. These panels are very flexible. You can 
expand, close, or minimise them quickly and easily. You can also reduce the 
panels to icons, providing greater space for sharing documents, applications, 
and other items with meeting participants.  



  

PANEL OVERVIEW  

Your service selects which panels display initially. 
 

  
 

MINIMISING AND RESTORING PANELS  

 
Minimising and restoring panels has no effect on attendees’ displays.  
 
To minimise a panel:  
 
Click the Minimise icon on the title bar of the panel you want to minimize. 
 

 
 
The panel no longer displays. It appears as an icon on the icon tray at the top of 
the panels. 
 

To display the Select 
Panel menu, click Panels.  

In this example, the 
Polling panel is 
minimized. Click Polling 
in the icon tray to restore 
it. 

The Video panel is collapsed. 
Use the icon on the left side 
of the panel title bar to 
collapse or expand a panel. 

You can minimise all the 
panels at once using the 
Minimize All command.

Click the Minimise icon to 
minimize this panel 

Minimised panels display as icons. 



  

 

 
 
 
To restore a minimised panel:  
 
Click its icon on the icon tray. 
 

 
 
To minimise all panels:  
 
1 On the icon tray, click Panels.  
 
The Select Panel menu displays. 
 
2 On the Select Panel menu, choose Minimise All.  
 
The open panels shrink to icons on the icon tray. 
 

 
 
To restore all minimised panels:  
 
The Restore All command quickly restores all panels you have minimised using 
the Minimise All command. 
 
1 In the icon tray, click Panels.  
 
The Select Panel menu displays. 
 
2 On the Select Panels menu, choose Restore All.  
 
Minimised panels now display.  
 

EXPANDING AND COLLAPSING PANELS  

 
Expanding and collapsing panels has no effect on the attendees’ displays.  
 
To collapse a panel:  
 
Click the icon in the upper left corner of a panel to collapse it.  
 
The panel collapses, leaving just the title bar visible. 
 
Use the icon on the left side of the panel title bar to collapse or expand a panel.  
 

Click to restore. 



  

 
 
To expand a panel:  
 
If a panel is collapsed (you only can see its title bar), click the icon in the left 
corner of the title bar to expand it.  

OPENING AND CLOSING PANELS  

You can hide a panel completely so it will not display as an icon on the icon tray. 
If you close a panel, that panel also closes for attendees. It remains closed for all 
attendees until you open the panel again.  
 
To close a panel: 
 
1 On the icon tray above the panels, click Panels.  
 
The Select Panel menu displays. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2 On the Select Panel menu, click to remove the check mark next to the panel 

you want to close.  
 
The panel no longer displays and it is not available as an icon on the icon bar.  
 
If you close the last remaining panel, the large panel area on the right side of the 
screen disappears. You still have access to the panels through the Select Panel 
menu, available by clicking the Select Panel button. 
 

 
 

The Video panel is 
collapsed 

Panels without check marks 
are currently closed.

Panel with checkmarks 
currently display. 



  

To open a panel:  
 
1 On the icon tray above the panels, click Panels.  
 
The Select Panel menu displays. 
 
2 On the Select Panel menu, click to place a check mark next to any panel you 

want to open. The panel or panels you selected display.  
 
This panel is now available for all attendees.  
 
Resetting the panels 
 
You can return the panels to the display settings that were preset by your 
service. 
 
1 On the icon tray above the panels, click Panels.  
 
The Select Panel menu displays. 
 
2 On the Select Panel menu, choose Reset to Default.  
 
The panels return to the display settings originally selected by your service. The 
size, order, and location of the panels are reset to their original settings.  
 
 
ACCESSING PANEL OPTIONS  
You can easily access the options related to any panel. Simply right-click in the 
panel title bar to see a menu of commands related to the panel. 
 
Panel  Options 
Participants Sound Alerts: Lets you choose a sound to play when 

a participant:  
 Joins a meeting 
 Leaves a meeting 
 Selects the Raise Hand button on the Participants 

      panel.  
 
Attendee Privileges: Displays the Participant 
Privileges dialog box. For details about privileges, see 
Participant roles and privileges. 

Chat Sound Alerts: Lets you choose the kinds of chat 
messages for which you want a sound to play. Select 
a sound from the drop-down list or click Browse to find 
a sound in a different location on your computer. 
 
Attendee Privileges: Displays the Participant 
Privileges dialog box. For details about privileges, see 
Participant roles and privileges. 

Video  Single-point video: Lets only the presenter on one 
participant send live video during the meeting.  
 
Multipoint video: Lets the presenter and up to three 
other participants send live video during the meeting. 
This option uses more resources on your computer 
and bandwidth for your Internet connection, which 
may affect the performance of Meeting Manager.  
 



  

Video Options: Displays the Meeting Options dialog 
box, where you can set video options as well as other 
options you want to make available during the 
meeting. 

Notes Notes: Displays the Meeting Options dialog box, 
where you can set note-taking options as well as other 
options 
 

 Allow all participants to make notes: Lets all 
participants take their own notes during the 
meeting, and save them to their computers. 

 Single note taker: Lets only one participant take 
notes during the meeting. By default, the host is 
the note-taker, but can designate another 
participant as the note-taker during the meeting. A 
note-taker can publish notes in all participants’ 
Meeting windows at any time during the meeting. 
The host can send a transcript of the notes to 
participants at any time. 

 
Enable closed captioning: Lets one participant—the 
closed captionist—transcribe notes during the 
meeting. 

 

RESIZING THE CONTENT VIEWER AND PANELS AREA  

You can control the size of the content viewer by making the panel area 
narrower or wider.  
 
To change the size of the content viewer and panels:  
 
Click the dividing line between the content viewer and the panels. 
 

 Drag the line to the left to make the area devoted to the panels wider. 
 Drag the line to the right to make the content viewer larger. 

 

 
Drag this line to the right or left to change the size of the content viewer and panels 
area 
 
For details about hiding, minimising, and closing the panels, see Panels and full-
screen view, next.  

PANELS AND FULL-SCREEN VIEW  



  

While you are viewing or remotely controlling a shared application, desktop, or 
Web browser, or viewing a shared remote computer, a presenter can switch 
between a standard window and full-screen view.  
 
In full-screen view, you access the panels on a floating icon tray located in the 
lower right corner of your screen. 
 
 
 
 
 
 

 
 
 
 
 
 
To display a panel in full-screen view:  
 
Click its icon on the floating icon tray. For example, to display the Chat panel, 
click the Chat icon.  
 
The panel “floats” on top of the shared document, presentation, web browser or 
other shared item. You can drag the panel to move it. 
 

 
 
To open all panels in full-screen view:  
 
You can have all panels float on top of the shared document, presentation, web 
browser, or other shared item. 
 
1 On the floating icon tray, click the Select Panel button.  
 

It is the last button on the floating icon tray. 
 
2 On the Select Panel menu, choose Float All Panels. 
 
All panels display, even those you had minimised previously.  
 
What you can do  

Participants 

Chat 

Video Polling 
Return to 
Meeting 
Window

Notes Select Panel Tools Move 
handle 



  

 
Resize individual panels using the Resize Control in the bottom right corner of 
any floating panel. 
 
 
 
 
 
 
 
 
 

 
 
 
To organise the floating panels: 
 
As you reopen the panels to jot a few notes or chat with a participant, you may 
find you need to arrange the panels. 
 
1 On the floating icon tray, click the Select Panel button.  
 
It is the last button on the floating icon tray. 
 
2 On the Select Panel menu, choose Open Right Panel.  
 
An empty panel appears on the right side of the screen.  
 
The icon tray now resides at the top of the right panel. 
 
What you can do  
Drag any floating panels into this larger panel. Panels resize to fill the space. 
 

Drag the Resize Control to 
change the size of the panel 



  

 
 
 
 

 Drag the panel out of the larger panel to “float” it. 
 

 Switch between full-screen view and standard view.  
 
After you return to standard view, all panels (those that are floating and those 
that you have minimized) return to their preset locations in the right panel.  
 

SHARING AND FULL-SCREEN VIEW  

In full-screen view, you have access to sharing and viewing options from the 
Select Panel menu. 
 
If you are sharing a document  
 
If you have already opened several documents, you can switch to share any of 
these documents.  
 
 
 
 
To display a different document: 
 
1 On the floating icon tray, click the Select Panel button. It is the last button on 

the floating icon tray. 

Drag individual panels 
into the panel on the 
far right of the screen.  
 
The panels align and 
resize inside the larger 
panel. 



  

 
2 On the Select Panel menu, choose Select Document. You see a list of 

documents that are currently open in this meeting. 
 
3 Select the document you want to share. 
 

 
Select a different document to share. 
 
To select another sharing option: 
 
1 In the floating icon tray, click the Select Panel button.  
 
It is the last button on the floating icon tray. 
 
2 On the Select Panel menu, choose Share. 
 
You see the list of sharing commands. 
 

 
Sharing commands 
3 Choose the kind of sharing you want to do.  
 
For details about these options, see Sharing documents and presentations and 
Sharing software.  
 
To resize the display of attendees to match your display: 
 



  

1 On the icon tray above the panels, click the Select Panel button.  
 
It is the last button on the floating icon tray. 
 
2 On the Select Panel menu, choose View > Synchronize Views. 
 
All attendees’ displays now match your display. 
 

 
 
Synchronize Views command 
 
 
If you are sharing an application  
 
 
To display a different document: 
 
1 On the floating icon tray, click the Select Panel button.  
 
It is the last button on the floating icon tray. 
 
2 On the Select Panel menu, choose Select Application. 
 



  

 
 
 
The Share Application dialog displays. 

 
3 Select the application you want to share. Or click New Application to open an 
application not already running on your desktop.  
 
To select another sharing option: 
 
1 On the floating icon tray, click the Select Panel button.  
 
It is the last button on the floating icon tray. 
 
2 On the Select Panel menu, choose Share.  
 
You see the list of sharing commands. 
 

 
Sharing commands 
 
 
 

3 Choose the kind of sharing you want to do.  
 

Select Application 
command 



  

For details about these options, see Sharing documents and presentations, and 
Sharing software.  
 
To resize the display of attendees to match your display: 
 
1 On the floating icon tray, click the Select Panel button.  
 
It is the last button on the floating icon tray. 
 
2 On the Select Panel menu, choose View > Synchronise Views. 
 
All attendees’ displays now match your display. 
 

 
 
Choose Synchronize Views 
 
 
 
If you are sharing a desktop  
 
To select another sharing option: 
 
1 On the floating icon tray, click the Select Panel button.  
 
It is the last button on the floating icon tray. 
 
2 On the Select Panel menu, choose Share.  
 
You see the list of sharing commands. 
 
3 Choose the kind of sharing you want to do. For details about these options, 

see Sharing documents and presentations and Sharing software.  
 
To resize the display of attendees to match your display: 
 
1 On the floating icon tray, click the Select Panel button.  
It is the last button on the floating icon tray. 
 
2 On the Select Panel menu, choose View > Synchronize Views. 
 
All attendees’ displays now match your display.  
 



  

PANEL ALERTS  

If you have closed, minimised, or collapsed any panels, you will see an alert if a 
panel you no longer can see requires your attention.  
 
Some reasons for seeing alerts: 
 

 A participant arrives or leaves a meeting 
 A Raise Hand indicator appears in the Participants list 
 The note taker publishes notes 
 An attendee sends a chat message 
 A poll opens or closes 
 Poll answers are received  

 
 
ALERTS FOR CLOSED PANELS  
If you have closed a panel, the Panels button changes color to alert you to a 
change. For example, if a participant leaves your meeting, and you have closed 
the Participants panel, the Select Panel menu button turns into an alert. 
 

 

ALERTS FOR MINIMISED PANELS  

If you have minimised a panel, the icon representing that panel alerts you of a 
change. 
 

The Chat icon changes color to 
let you know you have a new 
chat message. 

 

 
ALERTS FOR COLLAPSED PANELS  

 
If you have collapsed a panel, the Expand/Collapse icon changes color when 
you need to pay attention to that panel. 
 

The icon changes color to let you know 
you should check the contents of this 
panel. 
 

Panels button changes color to alert you.  
In this example, a participant has left the 
meeting.  The Participants panel is 
closed, so an alert is sent. 

The panel requiring attention is 
highlighted. 



  

 
 

Understanding the Participants Panel 
 
In addition to the list of people currently attending your meeting, the 
Participants panel provides other information about the attendees. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

The following table describes the possible indicators that may appear in the 
participant list. 
 
 
Indicator Indicator Name Description 

(host) Host indicator Indicates the meeting host. 

 
Presenter indicator Indicates the current 

presenter. 
 Annotation Color indicator Indicates the color with 

which the participant can 
annotate shared content. 
Participants can select 
another color with which to 
make annotations, but their 
assigned colors in the 

Integrated VoIP Participant 

Ask to 
speak

Note Taker 

Annotation Color 

Presenter 

Host 
Speaker  
(integrated VoIP) 

 Participant 
Ready  

Speaker is not 
muted 
(teleconference)

Muted Speaker 
(teleconference) 

Active Talker 
indicator  



  

participant list remain the 
same. 

 

Participant Ready indicator Indicates that the 
participant’s content viewer 
is displaying the page, slide, 
or whiteboard that the 
presenter is sharing. Can 
appear in different states, 
each of which indicates the 
percentage of the content 
that has loaded in the 
participant's content viewer. 

 Speaker indicator for 
teleconference 

In an integrated 
teleconference, indicates 
that the participant is 
connected to the 
teleconference and his or 
her microphone is not 
muted—that is, the 
participant can speak. 

 Muted Speaker indicator for 
teleconference 

In an integrated 
teleconference, indicates 
that the participant is 
connected to the 
teleconference but his or her 
microphone is muted. 

   
   
   

 

Ask to Speak indicator In the host’s and presenter's 
participant list only, indicates 
that the participant has 
clicked the Raise Hand 
button. 

 

Note Taker indicator Indicates the single note 
taker for the meeting, if the 
host designated a note 
taker. 

   
 

SENDING A CHAT MESSAGE TO PARTICIPANTS  

 
Chat is useful if you want to: 
 

 Communicate with a participant during a meeting that does not include a 
voice conference 

 Send a private message to another participant 
 Send brief information to all participants 
 Ask a question but do not want to interrupt the presenter  

 
To send a chat message:  
 
1 In the Meeting window, open the Chat panel. 
2 Type a message in the Chat box. 
3 In the Send to drop-down list, select the recipients of the message. 
 



  

 
Select the recipients of your chat 
message.  
 
To send a message to everyone, 
including the host, presenter, and 
attendees, choose All Participants  
 
To send to everyone except the 
host and panelists, choose All 
Attendees.  
 
To send a chat message to a 
particular participant, select the 
name in the list.  
 
 
 
 
 
 
 

 
 

4 Click Send.  
 

The recipients receive the chat message in their chat viewer.  

ABOUT TAKING NOTES  

During a meeting, one or more meeting participants with access to the notes 
feature can take notes on the Notes or Closed Caption panel in the Meeting 
window. Only one participant transcribes closed captions.  
 
If all participants with access take notes, they cannot publish their notes to 
others during the meeting. However, participants can save their notes at any 
time during the meeting.  
 
If only a single participant can take notes or perform closed captioning, the 
meeting host can select the single note taker or closed caption provider during 
the meeting. A single note taker can publish notes at any time during the 
meeting or send a meeting transcript containing the notes to all participants. A 
closed caption provider can publish captions in real-time during the meeting and 
can also send a transcript containing the captions to all participants.  
 

TAKING PERSONAL NOTES  

If the meeting host or presenter has selected the option to allow participants to 
take personal notes, you can type your notes on the Notes panel in the Meeting 
window.  
 
To take personal notes: 
 
1 In the Meeting window, open the Notes panel. 
2 Type your notes in the box.  
 
Note: You can save your notes to a text file on your computer. For details, see 
Saving notes to a file.  



  

TAKING PUBLIC NOTES (MEETING MINUTES)  

If the meeting host has designated you as the single note taker for a meeting, 
you can type notes on the Notes panel in your Meeting window. Your notes are 
not visible to other meeting participants until you publish them. You can publish 
your notes at any time during the meeting, or you can send your notes in a 
meeting transcript to all participants.  
 
 
To take public notes: 
 
1 In the Meeting window, open the Notes panel. 
2 Type your notes in the box. 
3 Optional. To publish your notes, so they appear in each participant's Notes 

panel, click Publish. 
 
Note: For details about sending public notes in a meeting transcript, see Sending a 
meeting transcript to participants.  
 
 
 
 
SAVING NOTES TO A FILE  
If you are taking personal or public notes or closed captions during a meeting 
you can save your notes to a text file on your computer. You can also save any 
notes or closed captions that another note taker or closed captionist publishes 
on your Notes or Closed Caption panel.  
 
Once you save new notes to a file, you can save changes to the notes or save a 
copy of the notes to another file.  
 
To save new notes:  
 
1 In the Meeting window, perform either task:  
- On the Notes or Closed Caption panel, click Save. 
- On the File menu, point to Save, and then choose Notes or Closed Captions.  
 
The Save Notes As dialog box appears. 
 
2 Choose a location at which to save the file. 
3 Type a name for the file. 
4 Click Save. 
 
Meeting Manager saves the file at the location you chose. Its file name has a 
.txt extension.  
 
To save changes to notes: 
  
In the Meeting window, do either of the following: 
 

 On the Notes or Closed Captions panel, click Save. 
 On the File menu, point to Save, and then choose Notes or Closed Captions.  

 
Meeting Manager saves the file at the location you chose. Its file name has a .txt 
extension.  
 
 
To save a copy of notes to another file: 



  

1 In the Meeting window, on the File menu, point to Save As, and then choose 
Notes. The Save Notes As dialog box appears. 

2 Do either or both of the following: 
- Type a new name for the file. 
- Choose a new location at which to save the file. 
 
3 Click Save.  
 
Meeting Manager saves the file at the location you chose. Its file name has a .txt 
extension. 
 
Tip: Alternatively, you can save all of the following meeting information to files at 

once: 
 shared presentations or documents 
 chat messages 
 poll questionnaire 
 poll results 
 notes  

 
To save all information at once, on the File menu, choose Save All. In this case, 
Meeting Manager uses the default file names for the files. Thus, if you have 
already saved a file using another name, Meeting Manager does not overwrite 
that file.  
 
 
 
 

SETTING UP VIDEO  

If a video camera is attached to your computer, you can send live video to 
meeting participants. Live video lets other participants see you, an object under 
discussion, and so on. All participants can view live video that you send, without 
the need for video equipment installed on their computers.  
 
To set up video, you must connect a video camera—also called a webcam— to 
your computer. Once you start or join a meeting, Meeting Manager automatically 
detects your video camera.  
 
Generally, Meeting Manager is compatible with any video camera that connects 
to your computer's USB or parallel port. The quality of the video image can vary, 
depending on the quality of the video camera that you use. For a list of video 
cameras that are known to be compatible with your Meeting Manager software, 
refer to the Frequently Asked Questions (FAQ) page on your meeting service 
Web site. You can access this page from your site’s Support page.  

SENDING LIVE VIDEO  

If the single-point video option is turned on, only the presenter or another 
participant selected by the presenter can send live video. If the multipoint video 
option is turned on, up to four participants whose computers have a video 
camera can send video. Only the presenter or another participant selected by 
the presenter can send live video. 
 
To send live video: 
  
In the Meeting window, display the Video panel on the right side of the Meeting 
window. For details about using the panels, see Working with the panels.  
 



  

Meeting Manager begins sending live video immediately. To send live video, you 
must connect a video camera to your computer.  
 
For details, see consult the documentation that accompanied your camera.  
 

POLLING ATTENDEES  

During a meeting, you can poll attendees by providing a questionnaire with 
multiple-choice answers. Taking a poll can be useful for gathering feedback from 
attendees, allowing attendees to vote on a proposal, testing attendees' 
knowledge of a topic, and so on.  
 
To take a poll, you must first prepare a poll questionnaire. You can prepare a 
questionnaire at any time during a meeting. Or, to save time during a meeting, 
you can prepare a questionnaire before the meeting starts, save it, and then 
open it during the meeting.  
 
Once attendees complete a poll, you can view the results and share them with 
attendees. You can also save the results of a poll for viewing outside of a 
meeting.  
 

PREPARING A POLL QUESTIONNAIRE  

During a meeting, you can prepare a poll questionnaire that includes multiple-
choice answers. Once you complete a questionnaire, attendees can respond to it 
during a meeting. 
 

 
 
 
SENDING A MEETING TRANSCRIPT TO PARTICIPANTS  
As a meeting host, single note taker, or closed captionist, you can send a 
transcript of a meeting in an email message to all participants at any time before 
the meeting ends. The transcript, which Meeting Manager creates automatically, 
contains the following information: 
 

 meeting topic 
 meeting number 
 meeting starting and ending times 
 the list of all participants 
 the meeting agenda 
 any public notes or closed captions that you took during the meeting, if you 

saved them to a file  
 
You can optionally attach any of the following files to the transcript message, if 
you saved them during the meeting: 
 

 shared documents 
 poll questionnaire 
 poll results 

Sample poll questions 



  

 chat messages 
 public notes or closed captions 

 
For security purposes, each transcript email message that a participant receives 
does not display the email addresses for other participants.  
 
 
Important: To receive a transcript email message, a participant must provide his or 
her email address when joining the meeting.  
 
 
 
To send a meeting transcript to participants: 
 
1 On the File menu, choose Send Transcript. 
2 (Optional) To include any files or other data shared or presented in the 

meeting, select the “Attach meeting and data files” check box. 
 

      
 

3 (Optional) Select the check box for any files that you want to attach to the 
transcript email message, and then click OK. 

4 In the new email message that appears, review the content and make any 
necessary changes. 

5 Send the transcript email message. 
 

Managing Meetings 
 
PARTICIPANT ROLES AND PRIVILEGES  
Each participant in an online meeting has one of the following roles: host, 
presenter, or attendee. These roles determine which options you can use on 
your MeetingCentre Web site and in Meeting Manager. 
 
Role Responsibilities and options 
Host A meeting host must have a user account on your 

MeetingCentre Web site. A host can schedule, start, and 
control a meeting; and assign meeting roles to other 
participants. Initially, the host is also the presenter; 
however, the host can make any participant the presenter 
during the meeting. 

Presenter Only one participant at a time can be the presenter, but 
participants can take turns being the presenter during a 
meeting. A presenter can: 

 Share and annotate presentations, documents, and 
whiteboards 



  

 Share software, and grant remote control of shared 
software to participants 

 Assign meeting privileges to other participants 
 Turn various meeting options on or off 
 Poll participants 
 Transfer files to participants 
 Send live video, and select which participants can send 

video  
Attendee Attendee A meeting attendee participates in a meeting but 

generally does not present information. Attendees can view 
shared information and interact with it, if the presenter 
assigns the appropriate privileges to them. An attendee can 
also perform other tasks, such as recording a meeting, if he 
or she has the appropriate privileges. 

 
ABOUT GRANTING PRIVILEGES TO ATTENDEES  
Once a meeting starts, all meeting attendees automatically receive privileges: 
 

 If the host scheduled the meeting and specified attendee privileges, 
attendees receive those privileges. 

 If the host scheduled the meeting but did not specify attendee privileges, 
attendees receive the default privileges. 

 If the host started an instant meeting, attendees receive the default 
privileges.  

 
You can grant or remove privileges for the following meeting activities: 
 

 Document sharing, including privileges for saving, printing, and annotating 
shared content in the content viewer 

 Viewing miniatures, or thumbnails, of pages, slides, or whiteboards in the 
content viewer 

 Zooming in and out on pages, slides, and whiteboards in the presentation 
viewer 

 Viewing Any page, slide, or whiteboard in the content viewer, regardless 
of the content that the presenter is viewing 

 Controlling full-screen view of pages, slides, or whiteboards in the content 
viewer Viewing the participant list 

 Chatting with participants 
 Recording a meeting 
 Requesting remote control of shared applications, desktops, or Web 

browsers 
 Contacting the operator for a teleconference privately, if your meeting 

service includes the private operator option  

 
GRANTING ATTENDEE PRIVILEGES DURING A MEETING  
During a meeting, you can grant privileges to or remove them from all attendees 
at once or an individual attendee.  
 
To specify attendee privileges during a meeting: 
 
1 In the Meeting window, on the Participant menu, choose Participant 

Privileges. The Attendee Privileges dialog box appears. 
2 Perform either task: 
 
- To grant privileges to or remove them from all attendees at once, in the pane 

on the left, select All Attendees. 



  

- To grant privileges to or remove them from an individual attendee, in the 
pane on the left, expand All Attendees, and then select the attendee's name. 

 
3 Specify attendee privileges: 
 
- To grant a privilege to attendees, select its check box.  
- To grant all privileges to attendees, select the Assign all privileges check box. 
- To remove a privilege from attendees, clear its check box. 
- To reset to the preset meeting privileges, click Reset to Meeting Defaults. 
 
4 Click Assign.  
 
 
 

Controlling a meeting  
As a meeting host, you can control many aspects of an online meeting.  

INVITING ATTENDEES TO A MEETING IN PROGRESS  

Once you start a meeting, you can invite additional attendees to the meeting. 
You can invite attendees by phone, email, or instant message.  
 
Tip: If the Quick Start option is turned on, you can invite attendees from the Quick 
Start tab as well as from the Participant menu  
 
To invite an attendee by email to a meeting in progress: 
 
1 On the Participant menu, point to Invite, and then choose By Email. 
2 Type the attendee’s email address. 
3 Click Send Invitation.  
 
Each person that you invite receives an invitation email message that contains 
information about the meeting—including the password—and a link that the 
attendee can click to join the meeting. 
 
 
 
 

DESIGNATING A PRESENTER  

 
As a meeting host, you are initially the presenter as well. However, you can 
designate any attendee as the presenter. You can also reclaim the presenter 
role or change the presenter at any time.  
 
To designate a presenter: 
 
1 In the participant list on the Participants tab, select the name of the attendee 

whom you want to designate as the presenter. 
2 Below the participant list, click Presenter.  

TRANSFERRING THE HOST ROLE  

As a meeting host, you can transfer the host role—and thus all control of the 
meeting—to an attendee.  
 



  

To transfer the host role: 
 
1 In the participant list on the Participants tab, select the name of the attendee 

to whom you want to transfer the host role. 
 
2 On the Participant menu, point to Make, and then choose Host.  

EXPELLING A PARTICIPANT  

You can remove, or expel, a participant from a meeting at any time.  
 
To expel a participant: 
 
1 In the participant list on the Participants tab, select the name of the 

participant whom you want to expel. 
2 On the Participant menu, choose Expel.  
 
 

LOCKING AND UNLOCKING A MEETING  

Once you start a meeting, you can restrict access to it, or “lock” it. This option 
prevents anyone else from joining the meeting. You can unlock a meeting at any 
time.  
 
To lock a meeting:  
 
On the Meeting menu, choose Restrict Access.  
 
To unlock a meeting:  
 
On the Meeting menu, choose Restore Access.  
 

ENDING A MEETING  

Once you end a meeting, the Meeting window closes on all participants’ screens. 
If the meeting includes an integrated voice teleconference, the conference also 
ends.  
 
To end a meeting: 
 
1 On the File menu, choose End Meeting.  
2 In the confirmation message that appears, click Yes.  
 

VIEWING USAGE REPORTS  

If your MeetingCentre Web site includes the reports option, you can view the 
following types of usage reports: 
 

 Meeting Usage report—Contains detailed information about each meeting 
that you host, including information about each participant. 

 
 Access Anywhere Usage report—Contains detailed information about the 

computers that you access remotely and your Access Anywhere sessions, if 
your site or account includes the Access Anywhere option.  

 
To view a usage report: 



  

 
1 Log in to your MeetingCentre Web site. 
2 On the navigation bar, click My WebEx. 
3 Click My Reports. 
4 Select the type of report you want to view. 
5 Specify a range of dates for which you want to view a report and how you 

want data sorted in the report. 
6 Click Display Report. 

 


